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Changing Password &Login ID

overview

This short tutorial will instruct you how to change your password and login ID. These tools are accessible
through links in the Tools and Resources tab.

Change Password1. 
Change Login ID2. 

change password

To change your password:

Click on Change Password in the left hand navigation bar.1. 
Type in your current password.2. 
Type in your new password.3. 
Type your new password again to confirm.4. 
Click on Done.5. 
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Here's a few password tips:

DO:

Use at least six characters in your password.
Longer passwords are harder to crack. Most Web sites have a minimum
requirement for password length.

◊ 
♦ 

Use a combination of numbers, special characters (for example: #, $, %, plus upper
and lower case letters.

Most Web sites are case−sensitive with regards to passwords. Passwords for
this site can contain special characters, though some sites forbid their use.

◊ 

♦ 

Change your password frequently.
At a minimum, consider changing one character in your password every few
months. Changing just one character will make it easier to remember your
new password.

◊ 
♦ 

DON'T:

Don't use a password that could be found in a dictionary.
A password consisting of only a word is easy to crack.◊ 

♦ 

Don't share your password with others.
If you are forced to divulge your password, change it immediately.◊ 

♦ 

Don't use a four digit PIN (ATM personal identification number) as a password.
Short numeric passwords are quite easy to crack.◊ 

♦ 

change login ID

To change your Login ID:

Click on change Login ID in the left hand navigation bar.1. 
Type in your current password.2. 
Type in your new login ID.3. 
Type in your new login ID again to confirm.4. 
Click on Submit Query.5. 
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Chat

overview

Sections:

Accessing Online Chat1. 
Flash Chat Rooms

User Names♦ 
Controls♦ 

2. 

JavaScript Chat Rooms
User Names♦ 
Controls♦ 
Status Indicators♦ 

3. 

Chat is a multi−user text−based discussion area where conversations occur in real−time (live). The Chat
Rooms require a JavaScript enabled browser or the Flash Player plug−in.

accessing online chat

To access the chat rooms, click on the Communication tab found on the top of the screen, then click on the
Chat Rooms link. The current number of people in that room is displayed next to each Chat Room name.
This number updates every 8 minutes.

There are two types of chat room engines: one uses Macromedia FLASH and the other runs on JavaScript.
Here's a quick description of each version:

Flash Version

Give this version a try first, it will work best for most people. You'll need
Flash 5 (or above) to use this Chat Room system. If you don't have the proper
version of Flash, you'll be directed to the Macromedia site to download the
free software. This version offers better reliability for people who have
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problems staying connected to the JavaScript Chat Room version.

JavaScript Version

The JavaScript Chat Room system is best for those who don't have Flash
installed on their computers.

Joining a conversation with either version is easy; simply type your comments in the box at the bottom of the
chat box and press ENTER (RETURN) on your keyboard. The comments you add, as well as comments made
by other participants, will automatically scroll as the conversation progresses.

Layout and function of both chat room systems is very similar. In the next sections we'll take a closer look at
each chat room version.

flash chat rooms

User List: Click the down arrow button to toggle between the user list view and the chat−room view.
(The image above shows the user list view.)

• 

Chat With: If you are privately conversing with another person, this area of the chat room will display
the login ID of that person. You can chat with a particular person by clicking on the person's name.
Only the person listed in the chat with section will see your message. While chatting with a specific
person, a small icon with a plus sign will appear next to chat with. Click on the small icon to return to
chatting with everyone in the room.

• 

login ids
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Icons shown in gray represent people who have identified themselves as "away." These people are
temporarily not participating in the chat room.

• 

Click on a person's icon to display their information, such as: e−mail address, phone number, address
and picture. (Each person chooses what information is displayed to others.)

• 

Click a person's name to chat with only them.• 

controls

There are four buttons that control chat features:

CLEAR: Clears text in chat window.• 
WHO: Displays a list of current participants in all of the Chat Rooms.• 
HELP: Displays help.• 
EXIT: Closes the chat tool.• 

javascript

CHANGE ROOM: Click on the pull−down menu to change rooms at any time. You'll see the names
of all of available Chat Rooms; the number that appears to the right of each room name represents the
number of people in that room.

• 

CHAT WITH: This feature allows you to privately converse with another person. To chat with a
particular person, find their name in the list and select it. Private chat messages are identified by light
blue colored text. To talk with all the people in the room, select "All in the room."

• 

login ids
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Just below the pull down menus is a list of login ID's and icons of persons
in the room.

• 

Names shown in gray represent people who have identified themselves as "away." These people are
temporarily not participating in the chat room.

• 

You can click on a person's Icon to display their information, such as: e−mail address, phone number,
address and picture. (Each person chooses what information is displayed to others.)

• 

controls

There are four buttons that control chat features:

CLEAR: Clears text in chat window.• 
WHO: Displays a list of current participants in all of the Chat Rooms.• 
HELP: Displays help.• 
EXIT: Closes the chat tool.• 

status indicators

These indicator boxes display a person's status and other information. Each box is followed by the
time and then a short textual message. Status Boxes include:

JOIN: Informs everyone that a new person has entered the room.• 
PART: Informs everyone that a person has departed from the room.• 
NOTE: Informs a person to type "/help" to access a list of chat commands.• 
ERROR: Informs a person that they have entered an unknown command.• 

Cookies

overview

Sections:

Internet Explorer v.4.0 / 4.51. 
Internet Explorer v.5.02. 
Internet Explorer v.5.0 (Mac OS 9)3. 
Internet Explorer v.5.2 (Mac OS X)4. 
Internet Explorer v.6.05. 
Netscape v.4.0 / 4.5 / 4.6 / 4.7 / 6.06. 
Netscape v.6.2 / 7.07. 
Security / Privacy Issues8. 

A cookie is a small piece of information that's sent to your browser along with the Web page. After a cookie is
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sent by a Web server, your browser generally saves it on your computer's hard drive. Disabling the acceptance
of cookies makes interaction with some Web sites impossible, including this site.

We're concerned about your online security; the only information we store on your computer is a "session
variable" number that identifies you as an account holder.

This tutorial will instruct you how to enable cookies on your browser (if they are not currently enabled). There
are no significant differences in how Mac and PC versions of browsers accomplish this task.

internet explorer v. 4.0 / 4.5

Here are the simple steps to enable cookies in Internet Explorer v. 4.0 and 4.5:

Click Tools from your browser toolbar.1. 
Then Internet Options...2. 
Then click the Advanced tab.3. 
Scroll down the options until you find the Cookies category.4. 
Click the Enable option to enable cookies in your browser.5. 
Click OK.6. 

internet explorer v. 5.0
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Here are the simple steps to enable cookies in Internet Explorer v. 5.0:

Click Tools from your browser toolbar.1. 
Then choose Internet Options...2. 
Then click the Security tab.3. 
Now click the Custom Level... button under custom settings.4. 
Scroll down the options until you find the Cookies category.5. 
Now find Allow cookies that are stored on your computer.6. 
Click the Enable option to enable cookies in your browser.7. 
Click OK.8. 

internet explorer v. 5.0 (mac OS 9)

Here are the simple steps to enable cookies in Internet Explorer v. 5.0 Mac OS 9:

Click Edit from your browser toolbar.1. 
Then choose Preferences...2. 
Then click the Receiving Files tab.3. 
Now choose Cookies and...4. 
From the drop−down list, select the Never ask option to enable cookies in your browser. (You must
click Enable to be able to log in to this site).

5. 
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Click OK.6. 

internet explorer v. 5.2 (Mac OS X)

Here are the simple steps to enable cookies in Internet
Explorer v. 5.2 Mac OS X:

Click on the Explorer menu.1. 
Then choose Preferences...2. 
Expand the Receiving Files list.3. 
Now choose Cookies and...4. 
From the drop−down list, select the Never ask option to enable cookies in your browser. (You must
click Enable to be able to log in to this site).

5. 

Click OK.6. 

internet explorer v. 6.0
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Here are the simple steps to enable cookies in Internet Explorer v. 6.0:

Click Tools from your browser toolbar.1. 
Then choose Internet Options.2. 
The click the Privacy tab.3. 
Move the slider bar up and down to activate and set the privacy level for cookies (the text to the right
of the slider tells you the current settings for the level you have selected).

4. 

Click Apply then OK when you are done.5. 
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netscape v. 4.0 / 4.5 / 4.6 / 4.7 / 6.0

Here are the simple steps to enable cookies in Netscape 4.0 / 4.5 / 4.6 / 4.7:

Click Edit from your browser toolbar.1. 
Then choose Preferences...2. 
Then click the Advanced tab.3. 
Now choose Cookies and...4. 
Click the Enable all cookies option to enable cookies in your browser. (You must click Enable to be
able to log in to this site).

5. 

Click OK.6. 

netscape v. 6.2 / 7.0

Here are the simple steps to enable cookies in Netscape v. 6.2 / 7.0 :

Click Edit from your browser toolbar.1. 
Then choose Preferences...2. 
Then click the Privacy & Security tab.3. 
Now choose Cookies and...4. 
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Click the Enable all cookies option to enable cookies in your browser. (You must click Enable to be
able to log in to this site).

5. 

Click OK.6. 

security / privacy issues

Whenever changing the security and/or privacy settings in your browser, there are a few things to keep in
mind to ensure this site will operate correctly for you.

Be sure that your computer accepts Cookies. Setting your browser to "Block all Cookies" or
"Disabled" will prevent access to this site.

1. 

Be sure that Java Scripting (sometimes just called "scripts") is enabled in your browser.2. 

Course Navigation

course front page

Here's an overview of the buttons and features found on a course home page.
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Resume: Click here to be transported to the last page of course content accessed on your previous
session.

1. 

Begin the Course: Takes you to the first page of course content.2. 
Course Materials: Access to supplemental course materials.3. 
Portfolio Requirements: Direct access to the portfolio requirements for that course (if the course
requires a portfolio).

4. 

Go to Page: Type in the page number and click Go to instantly access a specific course page.5. 
Course Map: Access any page of the course (detailed information below).6. 
Course Tools: Quick access to other tools related to the course.7. 

internal course navigation

Once you click the Begin the Course button (see above), you'll see this navigation bar at the top and bottom
of each lesson page (as well as all the other features described in the section above):

This bar contains previous and next page buttons, as well as the current page number.

course map

The Course Map offers users a quick and easy way to jump to any page within a course.

Click the show all link to display an outline format of all pages within the current course.• 
The map is organized by lesson and page titles.• 
Red text "you are here" appears next to the name of the page you are currently viewing.• 

current location

Above the course title, you'll find a string of links that displays your current location within the course. You
may click on any link to jump back to a particular page.
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Discussion Forums

overview

Sections:

Accessing Discussion Forums1. 
Messages2. 
New Messages3. 
Search4. 
Forum Options5. 
New Topic6. 

Discussion forums give account holders a tool to communicate with multiple people simultaneously. It's
different than e−mail, because messages are posted to a public place −− not sent as private e−mail messages.
It's also different that chat, because communication doesn't take place in "real time" −− communication takes
place even if people are not online simultaneously.

Other terms often used for this tool include "bulletin board" or "discussion board." You can think the tool as a
"virtual" bulletin board in the same way you think of a bulletin board in the hallway of your school. When a
message is posted to your school's bulletin board it's a public message that is available to anyone who walks
by. Often a particular bulletin board at a school is defined by a subject area like Student Clubs, Sporting
Events or Job Announcements. This analogy holds true for virtual bulletin boards.

You will automatically be "subscribed" to Forums related to your school site, course list and profile. Messages
are displayed in a hierarchical format that visually groups comments by topic. Pictured to the right is an
example of a forum interface.
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accessing discussion forums

To access the forums, click on the Communication tab found on the top of the screen, then click on the
Discussion Forum link. In addition, you may access forums by click on the Recent Discussions link found in
the lower portion of your Home Room.

messages

To view messages in a specific forum, click on the title of the forum to display all message. The number next
to the title indicates the number of messages in that forum.

Click on a specific title to read the message. You may post a new message at any time by creating a New
Topic, or by clicking on a forum, then on a specific message title, and then on Reply (more information in the
next sections). The system tracks which messages each account holder has viewed.

new messages

To view a message click on the underlined title of the message (a sample message is displayed below). Once
you've read the message you have several options:

Previous: Displays the message posted before the current message.• 
Next: Displays the message posted after the current message.• 
Print: Allows account holders to print specific messages by converting the message into a new
printer friendly screen. To print, use your browser's File menu to choose Print.

• 

Reply: This feature allows account holders to reply to a message by posting a message in that topic's
forum. Type your reply in the box titled Message. After your message is complete, click the check
box to be notified by e−mail when new messages are posted to that topic. Other options include:

Quote: Add the original message to your message.◊ 

• 
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Preview: To view what you have written before you post it publicly. While
previewing your message, you can make changes by clicking Re−edit, or if your
message is complete, click Post.

◊ 

Post: You can post your message without previewing by clicking the Post button.
This will post your message in the selected forum where other account holders can
view it and respond.

◊ 

Cancel: If you do not wish to reply simply press Cancel to return to the previous
screen.

◊ 

Check Spelling: You can check the spelling of your message before posting it to the
system.

◊ 

Edit: This feature allow account holders to change the messages they have personally posted. By
clicking Edit, you will be able to change the title of the message as well as the actual content of the
message. You can only edit those messages that you have created.

• 

Subscribe: Have the system e−mail you when new messages are posted to a topic (more E−mail
Notification below).

• 

search

A Search tool is located at the bottom of most
forum tool pages. The tool allows you to find
messages relating to specific topics in the forums,
without browsing from topic to topic. The tool also
allows you to narrow a search with an advanced
search tool located next to the standard search tool.

To perform an advanced search:

Type the keyword(s) for your search in the text box titled Query.• 
Click title to restrict your search to the titles of messages. Click title and text to search through both
the title and the actual content of the message.

• 

Then select the forum you wish to search by clicking on the title of the forum. You can choose more
than one forum by holding down your CONTROL key (PC) or the COMMAND key (Mac) and
clicking the desired forums with your mouse.

• 

Type a number in the text box titled Display to select the number of messages per page to display.• 
Check the expand messages check box to display the entire message in your results.• 

forum options

The Options button (at the top right of the main Discussion Forums page) allows account holders to
customize their settings. (The default settings are appropriate for most people.)

Let's explore the functions and features of each part of the Options box. Match the red numbers in the image
to the descriptions below.
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Topics Display:
Choose if you wish to Show all topics, show only new topics (since your last visit to the
forums) or Show topics from a certain number of days ago.

♦ 
1. 

List New Topics First:
Check this box to automatically display new topics first.♦ 

2. 

Signature:
Check this box to append a signature to your new posts; enter your e signature in the box
below.

♦ 
3. 

E−mail Notification: You can be notified via e−mail when new messages are posted to subscribed
topics. This feature saves you from having to return to the Forums to see new messages.

4. 

new topic

The New Topic button allows account holders to create new message topics in a forum by
entering the title into the text box and selecting a forum from the list.

Document Sharing

overview

Sections:

Accessing Document Sharing1. 
Submitting a Document2. 
Editing Your Documents3. 
Finding Documents4. 
Anatomy of an Entry5. 
Search6. 

Document Sharing allows users to submit files from their computer to a shared online database on our
system. You'll find a large assortment of files from lesson plans to PowerPoint presentations.

You can search or browse through files sorted by subject, or add your own files for others to access.
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accessing document sharing

There are two ways to access Document Sharing. The first method is to click on the Document
Sharing link after choosing the Tools tab.

The second method involves two steps:

Enter any course.1. 
Click on Document Sharing link on the left side of the screen.2. 

submitting a document

Follow these steps to share a document with other educators.

Click add new entry button and enter the title of your entry.• 

Find the file on your computer by clicking Browse. When you locate the file you wish to
share, click Open.

• 

Uploading Files

Some users have been experiencing difficulty uploading files (like
PowerPoint or Microsoft Word documents).

Workaround:
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Try another Browser (if you are using Internet Explorer switch to
Netscape, or vice versa).

1. 

Upload the file on a computer outside the school's network (for
example at home).

2. 

If you know how, try to reduce the size of the file. As a general rule,
files over about 1MB (1,000K) are considered large by some
networks.

3. 

We suspect many of the problems originate from the network at the
user's school. Some networks cannot reliably upload large files.
Contact your school's computer support personnel for assistance.

4. 

Mail the file as an e−mail attachment to help@ctaponline.org and
we'll attach it for you. (Unfortunately, many users who have been
unsuccessful in uploading files using the Document Sharing tool,
have also had problems successfully sending files as an e−mail
attachment.)

5. 

Last resort: Send the file by US Mail to: Butte County Office of
Education/ Instructional Resource Center, 5 County Center Drive,
Oroville, CA 95965.

6. 

Then choose a Category by clicking the drop−down arrow and select the appropriate
category for your resource.

• 

Next, select the appropriate grade level(s) for your document. You may choose all grade
levels by checking All.

• 

Now enter a short description of your file. Other members will be able to read your
comments.

• 

Next, select who you wish to share this file with by selecting: Only Myself, Choose Users...,
or Everyone. To share with specific group members or Leaders choose Group Members or
Group Leaders.

• 
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Finish by clicking Done, or if you wish to start over, click Cancel.• 

editing your entry

The entries in the my documents box (the upper left corner) reflect those that you have personally entered.
Since you are the "owner" you may edit, change sharing and delete your entries.

finding resources

To view a document, click on a selected category.

After choosing your selected category, you will see all the documents posted within that category. To
view a document, simply click on the filename.

anatomy of an entry

The Document Sharing tool gives you several options for sorting the displayed files:

Title − Sorts the entries alphabetically by title.1. 
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Category − Sorts the entries by category.2. 
Submitter − Sorts the entries alphabetically by the submitter's name.3. 
Date − Sorts the entries in date order.4. 

Once you've sorted by any of these criteria, you can toggle between ascending or descending order by clicking
the yellow arrow up or down. Look below to see a list sorted by date, indicated by the yellow arrow.

Title of the resource (short description)1. 
Icon displaying the file type of the resource (e.g., Microsoft Word)2. 
File name3. 
File size4. 
Description of the resource5. 
Resource category6. 
Member ID of person who submitted file. Click on the Member ID to view the member's
profile

7. 

Date file was submitted8. 
Grade level9. 

Title of the resource −− Click to download the document. (NOTE: For maximum safety when
downloading files, always have an up−to−date virus checking program running on your computer.)

• 

Icon displaying the file type of the resource (e.g., Microsoft Word)• 
The Web site's grade level and/or category.• 
The name of the person who posted the document.• 
The date which the document was entered into the database.• 
A short description of the Web site. You may toggle between Concise and Verbose (as shown above)
views of the description.

• 

search

You can search for resources by entering a keyword(s) into the search box and clicking Search. The tool will
display a list of resources containing your keyword.

Advanced Search options allow you to make your search more specific by narrowing the Category, Grade
Level, etc.

21



E−mail

overview

Sections:

Accessing E−mail1. 
Group Selection2. 
Sending to Specific People3. 
Sending to Group Leaders4. 
Re−Send Login Instructions5. 
Mass Mailing6. 

Our e−mail system allows you to e−mail other users without ever leaving the site. The system uses the e−mail
address you listed in your profile. You'll receive mail via your usual e−mail software (Outlook, Netscape
Mail, Eudora, HotMail, etc.).

A powerful feature of the system is its ability to easily send messages to multiple recipients.

accessing e−mail

To access e−mail click on the Communication tab at the top of the screen, then click on E−mail in the left
hand bar.

sending to specific people

Use this selection to e−mail specific people. When sending to multiple people, separate the names with a
comma.

If you have selected more than 50 people, please see the Mass Mailing section at the end of this document.

group selection
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If you are a member of multiple groups, use the list to select the group that you wish to e−mail. Hold down
the control key (command key on a Mac) while clicking to select multiple groups.

sending to group leaders

Use this selection to e−mail leaders in your group.

re−send login instructions

Use this selection button to re−send login instructions to any person. This is the same message an account
holder was sent when their account was initially set up. The message contains their login ID, password and
other important information.

mass mailing

To ensure the reliability of the mass mailing system, we store large mailings and sending them during
off−hours. Any message to more than 50 people will be delivered around 11pm on the day of the request.
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Home Room

overview

The Home Room is your personal portal page to courses, tools and features. The system recognizes you by
your login ID and displays information related to currently selected courses and your profile information.

Let's explore the functions and features of each part of the Home Room. Match the red numbers in the image
to the descriptions below.

1. The Tab Bar offers access to all tools and features:

Home Room: This link returns to the Home Room.• 
Information: Access to enrollment, college credit information and deadlines.• 
Courses: Provides access to your courses.• 
Tools: Document Sharing, Webliography, Lesson Plans, and other tools.• 
Communication: Discussion Forums, Chat, and E−mail.• 
Standards: Searchable database.• 
Site Map: One−click access to entire site.• 

2. my courses: This list reflects the courses you have selected.

3. Lower Panel: View announcements, review exemplary lesson plans, and more.
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Lesson Plans

overview

Sections:

Searching and Viewing Lesson Plans

Accessing Lesson Plans1. 
Finding Lesson Plans2. 
Sorting Lesson Plans3. 
Anatomy of an Entry4. 
Search5. 

Building Lessons

Lesson Title and Overview1. 
Lesson Sharing2. 
Standards Alignment3. 
Student Learning Objectives4. 
Student Activities5. 
Resources6. 
File Attachments7. 
Assessment8. 
Additional Comments9. 
Contact Information10. 

Other Features

Preview1. 
Lesson Review2. 

Our Lesson Plan tool has two basic functions: finding lesson plans made by others and building your
own lesson plans. The first part of this tutorial focuses on searching and viewing existing lessons, the
second part covers building new lessons and a final section covers a few remaining features.

accessing lesson plans

To access lesson plans, simply click on the Tools tab at the top of any page, then click on the Lesson
Plans link on the left hand side of the page.

finding lesson plans

The my lesson plans box shows only the entries you have made.• 
The shared lesson plans box displays resources shared with people you have selected, groups
and school sites.

• 

All resources posted appear in categories in the all lesson plans box.• 
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In the my lesson plans box, you have access to view all of the resources you have added to
our database. From here you are able to edit, delete, share, and create new entries. Look for
further information in the "Building a Lesson" section of this tutorial.

To perform any action on an entry, simply click the link under the name of the entry.

To view an entry, click on a selected category or grade level.

After choosing your selected category or grade level, you will see all of the entries posted within that
category or grade level. To view a lesson plan, simply click on the title of the lesson.

sorting lesson plans

The Lesson Plan tool gives you several options for sorting displayed files. You can sort entries by
Title, Submitter or Date by clicking on the underlined links. Once you've sorted by any of these
criteria, you can toggle between ascending or descending order by clicking the yellow arrow. Look
below to see a list sorted by date, indicated by the yellow arrow:
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anatomy of an entry

Title of the lesson1. 
Subject of the lesson2. 
The grade level associated with the lesson3. 
The author of the lesson (click on name to view profile information).4. 
The date which the lesson plan was entered into the database.5. 

search

You can search for resources by entering a keyword(s) into the search box and clicking Search.

Clicking on advanced search will allow you to narrow the search by Category, Grade Level, etc.

lesson title and overview

Follow these steps to build your own lesson and share it online with other educators.

Click on the Lesson Plan Builder button (located in the my lesson plans box), and enter the
title of your lesson plan.

• 

Click the pull−down menu and select a course (if any) that is associated with your lesson.
(This step is optional, so skip it if none of the courses are appropriate.)

• 
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Now select the appropriate subject area(s) for your lesson. If your lesson applies to more than
one subject, you may choose more than one. If your subject is not listed, please type a subject
in the Other text box

• 

Now enter the topic or focus of your lesson.• 

Next select the appropriate grade level(s) for the entry. You may choose all grade levels by
checking All.

• 

Enter a basic overview or summary of your lesson.• 

When the form is complete, click Save & Continue, or if you wish to return to Lesson Plans,
click Lesson Plans.

• 

Once you have completed the above steps, you will be taken to the Lesson Contents page
that lists the ten steps to building a lesson (each step has a section below). You may use the
ten steps sequentially, or in any order that makes sense for you.

• 

Lesson Review

When your lesson is complete, you can use the Lesson Review feature to have your
lesson reviewed by your Mentor and/or Site Administrator. The button will appear
when certain sharing criteria are met (described in next section). We'll fully describe
the Lesson Review process later in this document.

NOTE: Though this is an optional step, we strongly encourage that you request
review of your lesson before it is shared with others.
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lesson sharing

Follow these steps to share your lesson with other educators of your choice:

From the Lesson Plan table of contents page, click on Lesson Sharing.• 

Select the level of sharing from the drop down list. Click Save & Continue when you are done.• 

Once you have selected a sharing level, you may go back and change it at any time:

From the drop down list, select whether you want to keep sharing the same, change sharing, share
with only yourself, or everyone. Once you have made your selection from the list, click Save &
Continue.

• 

If you choose to change sharing, you will be presented with a new screen. In the text box, type in the
name of any person or group or site. Then click Search.

• 

Items that match your search will display in a list. Check the box next to persons you want to add,
then click Done.

• 

You can delete selections to your shared list by clicking the red X to the right of the name.• 
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standards selection

Here you'll select teaching standards that apply to your lesson. To begin, click add new
standard and follow the five steps below.

Choose the subject area and grade level appropriate to your lesson.1. 
There may be several layers of categories before you get to the actual standard.2. 
Select the appropriate standard link.3. 
After you have selected a standard, check all appropriate sub−standards that apply to your
lesson and click add.

4. 

You should now see a list of the standards you selected. You may add as many standards as
you wish by repeating these steps.

5. 

student learning objectives

Here you'll add student learning objectives to your lesson. Student learning objectives are stated in
terms of what a student will be able to do after instruction is complete. To begin, click add new
objective. When you are finished, click Save & Continue. Use the Check Spelling feature to check
your work.
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student activities

In this you'll create and submit a step−by−step description of what students will do in the lesson. To
describe the activities in your lesson, click add new activity. Add your activity step−by−step by
clicking save and continue after each activity.

Once you have added an activity, you will see a list of the activities along with a modify and delete
button. To change or edit a section of your activity, click modify. To delete a section of your activity,
click delete. You may add more steps by clicking add new activity. Change the order of the activities
by using the red and green arrows on the left side of the screen.

resources

This section of the Lesson Plan tool allows you to share information about resources that are needed for the
lesson. The resource categories are: Content Resources, Web Resources and Software/Hardware
Resources. Click add new to list a resource.
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file attachments

Now it's time to add any files from your computer that enhance your lesson. You may want to attach
files such as student samples, lesson rubrics or student handouts. To add a file from your computer,
click add new file.

Choose a short description for the file and then click Browse to find the file on your computer and
add it to the lesson. Once the file has been attached, the filename will appear in the window. Click
Upload File.
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You may add as many files as needed; to add more files, simply click add new file. You may also
modify or delete your previously added files.

Uploading Files

Some people have experienced difficulty uploading files (like PowerPoint or
Word documents) via the File Attachment feature of the Lesson Plan tool.
Here's a few tips:

Try another Browser (if you are using Internet Explorer switch to
Netscape, or visa−versa).

1. 

Upload the file on a computer outside the school's network (for
example at home).

2. 

If you can, try to reduce the size of the file. As a general rule, files
over about 1MB (1,000K) are considered large by some networks.

3. 

We suspect many of the problems originate from the school's
network. Some networks cannot reliably upload large files. Contact
your school's computer support personnel for assistance.

4. 

Mail the file as an e−mail attachment to help@ctaponline.org and
we'll attach it for you. (Unfortunately, many people who have been
unsuccessful in uploading files using the Lesson Plan tool, have also
had problems successfully sending files as an e−mail attachment.)

5. 

Last resort: Send the file by US Mail to: Butte County Office of
Education/ Instructional Resource Center, 5 County Center Drive,
Oroville, CA 95965.

6. 

assessment

Type your assessment strategies into the text box. Click Save & Continue when you are done.
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additional comments

This section allows you to add any other information that would be helpful for this lesson. Type in the
information then click Save & Continue.

contact information

This section allows you to enter, or modify, your contact information so that fellow teachers may contact you
regarding your lesson plans. As always, you have complete control over what information is visible to others.

preview

You may preview your lesson at any time by clicking the preview button in the upper−right corner of
each lesson builder page. Once you have clicked the preview button, a small screen will open. You
can edit any part of your lesson by finding the area you wish to change and clicking edit. You may
also go back to all lessons or, if you have made any changes, you may click refresh.
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lesson review

When your lesson is complete, you can use the Lesson Review feature to have your lesson reviewed by your
Mentor and/or Site Administrator.

In order to have your lesson reviewed, you must share it with someone other than yourself. Specifically, your
lesson must be shared with the person/people you wish to review your lesson.

Once you share your lesson, the Lesson Review button will appear at the bottom of the Lesson Contents
page (see below).

To request a review:

Click the Lesson Review button. The next window will contain a pre−written e−mail
message (shown below).

1. 

In the To field, select the people you want to review your lesson.2. 
You may type your own custom message into the Optional Message field.3. 
Click Send.4. 
A window will pop−up confirming names and e−mail addresses.5. 
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Once your lesson has been reviewed, you may read the comments by viewing your lesson plan. Sections with
comments will have an icon next to them (as shown below). Hide comments by clicking on hide mentor
comments in the upper right corner of the page.

Printing

printing individual pages

At the top of each course page is the Print This Page button. Clicking this button will print the current page
that you are viewing.

This button will not display on some browsers. If this button does not display in your browser, just go to the
File menu and select Print.
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Note: All course pages are designed so that when printed only the course content is printed; all other
components of the page are not printed.

printing multiple pages

At the top of each course page is the Print Multiple Pages button.

Clicking this button will bring up a new screen listing all the pages in the course. At the top of this page are
several options:

Page by page: prints each page you have selected on a separate pieces of paper.

Compiled: compiles all the pages you have selected into one long document with all the
white space removed. (This method of printing will use less paper).

Click the select all button to select all the pages in the course.

Once you are done selecting the pages you want to print and the printing options, click on Continue.

The next page will show all the course pages combined that you have selected to print.

Click the Print button in the upper right to print the material.

The Print button may not display on some browsers. If this button does not display in your browser, just go to
the File menu and select Print.

Required Software

The new version of our site (launched on February 3rd) uses cascading style sheets (CSS) The browsers below
are necessary to properly display the CSS technology we've employed to make our site Section 508
(Americans with Disabilities Act) compliant. In addition, newer versions of browsers add many enhanced
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features and faster operation.

Operating
System

Recommended
Browsers*

Minimum
Browsers**

Download

Windows Internet Explorer 6
Netscape 7

Internet Explorer 5.5
Netscape 6.1

Download
Download

Macintosh Internet Explorer 5
Netscape 7

Netscape 6.1 Download
Download

Alternate browsers (download latest versions):

Mozilla PC/Mac *
Opera PC/Mac *
Safari Mac **

* Fully supports all functionality and formatting.
** Fully supports all functionality, but may experience minor problems formatting some pages.

Search

accessing search

You can search thousands of pages with the click of a button, and narrow your search to certain portions of
the site. It's a fast and efficient way to find what you need.

To begin your search click the Tools tab from the top of most pages. Next, click on the Search link on the left
side of the screen.

search

To search:
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Enter a word or phrase in the text box.1. 
Choose the category of search you wish to perform. You can narrow searches for Course Content
and Academic Content Standards by using the (+) show all... link. (You may choose multiple
categories.)

2. 

Choose the number of entries you wish to view per page (10, 25, 50, or 100).3. 

search results

Once your search is complete you'll see a display of pages listed in order of relevance.

The title of each page displays as a clickable link.1. 
The relevance percentile gives you an idea of how likely a page contains the information you desire.2. 
Under each title you'll see a portion of the content of that page. Your key word(s) or phrase will be
highlighted in bold.

3. 

Spell Checking

overview

This short tutorial will guide you through the use of the spell checking tool. Look for the Check Spelling
button located near many text entry boxes.

Checking Spelling1. 
Editing Text2. 

checking spelling

After entering your text in the entry box, click Check Spelling.
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The prompt below will appear as your words are checked against the system dictionary. An animated display
of moving letters will appear under the text.

NOTE: Some browser and plug−in configurations will be unable to display the animated
prompt.

editing text

The spell checking tool identifies any words that are not in the dictionary and suggests alternatives. The first
choice suggested spelling is shown (see below). If all the words are correct, click Save &Continue to
complete the spell checking process.

If the first choice suggested spelling is not the correct, use the pull down menu to select the desired word (as
shown below).
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In our example sentence, the dictionary falsely identified "Online's" as an incorrect spelling and offered
"On−line's" as an alternative. Use the pull down menu to select the desired original spelling.

NOTE: Computer−based spell checkers sometimes offer suggestions that are inaccurate and
sometimes mark properly spelled words as misspelled. Always carefully check the suggested
words to ensure they are the intended words. Technical words and jargon are examples of
words that are sometimes misunderstood by the spell checking tool.

You can also type directly inside the text entry box to edit the words. Click the Check Spelling button again
to have the current words checked by the spell checker.

Once you are satisfied with the spelling, click Save &Continue to finish the spell checking operation.

NOTE: If the text you wish to check is more than a few paragraphs long, consider composing
and spell checking with your Word Processing software (for example: Microsoft Word). Cut
and paste the text from your word processor into the text entry box.

Standards Database
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overview

Sections:

Accessing and Viewing Standards1. 
Printing Standards2. 
Searching Standards3. 

Our State Standards database allows people to find any one of California's State Standards, sorted by Standard
Set, Subject and Grade level.

You can also search through the standards by entering a keyword into the search box.

accessing standards

To access our state standards database, click on the Standards tab found at the top of most any page.

Standards are sorted by standard set (for example: California Academic Content Standards, NETS, etc.),
subject and grade level:

Click on a preferred standard set.• 
Click a preferred subject area.• 
Click on a preferred grade level. (K−12).• 
Click on the desired standard.• 
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printing standards

Use your browser's File menu to select Print while viewing the desired standard.

searching standards

You can search for standards by entering a keyword(s) into the search box. Select a standards set from the
drop−down list, and then click Search. A list of standards containing your keyword will display.

User Contact Information

overview

Sections:

Accessing and Searching for User Contact Info1. 
Browsing for Users2. 
Viewing User Information3. 
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The User Contact Info tool allows you to access contact information for other people, such as their e−mail
address and telephone number.

NOTE: Your privacy is important to us. You have absolute control over what information is
displayed to others. Click on the Tools tab and then select Edit Profile link to modify the
information others see about you.

accessing user contact info

To begin, click on the User Contact Info link found on the left side of the page under the Communication
tab.

The system allows you to search by Name or Organization. Enter your search information in the text box and
click Search.

browsing for users

If you do not remember a specific name or organization, the User Contact system allows browsing lists of
users by Group Members, Group Leaders, and Site Administrators.

viewing user information

Search results provide several options for sorting the displayed information. Sorting can be done by Name,
Group, E−mail Address or Phone Number by clicking on the links above each list.

Once you've sorted by any of these criteria, you can toggle between ascending or descending order by clicking
the yellow arrow up or down. Look below to see a list sorted by Name, indicated by the yellow arrow.

Click on a name to display more information about that individual.
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Webliography

overview

Sections:

Accessing the Webliography Tool1. 
Submitting a Webliography Entry2. 
Editing Your Entry3. 
Finding Resources4. 
Anatomy of an Entry5. 
Search6. 

What is the Webliography?

A huge database of Web sites submitted by educators.• 
Each site has a short description and a handy clickable link.• 
The database is sortable and searchable.• 
The submiter controls who can view their entries.• 

accessing the webliography tool

There are three ways to access the Webliography:

The first method is to click on the Webliography link after selecting the Tools tab.1. 
The second method involves three steps:

Enter any course.◊ 
Click on Webliography link on the left side of the screen◊ 

2. 

The third method is by clicking in the Recent Webliography (bottom area) section
of your Home Room page.

3. 
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submitting an entry

Follow these steps to share a Web site with other educators.

Click add new entry button and enter the title of your entry.• 

Enter the Web address (URL) of the site into the box titled Web Address. Double check your
typing −− Web page addresses must be typed correctly.

• 

Then choose a Category by clicking the drop−down arrow and selecting the appropriate
category for the site.

• 

Now select the appropriate grade level(s) for the entry. You may choose all grade levels by
checking All.

• 
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Next, enter a short description of your entry. Other members will be able to read your
comments.

• 

Enter the name of the Web site's author, if known.• 

Next, select who you wish to share this file with by selecting: Only Myself, Choose Users...,
or Everyone. To share with specific group members or Leaders choose Group Members or
Group Leaders.

• 

Finish by clicking Done, or if you wish to start over, click Cancel.• 

editing your entry

The entries in the my webliography box (the upper left corner) reflect those that you have personally
entered. Since you are the "owner" you may edit, change sharing and delete your entries.

finding resources

To view a list of sites, click on a selected category or grade level.
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After choosing your selected category, you will see all of the entries posted within that category. To
view a Web site, simply click on the Web address (URL).

anatomy of an entry

The Webliography tool gives you several options for sorting the displayed files:

Title − Sorts the entries alphabetically by title.1. 
Category − Sorts the entries by category.2. 
Submitter − Sorts the entries alphabetically by the submitter's name.3. 
Date − Sorts the entries in date order.4. 

Once you've sorted by any of these criteria, you can toggle between ascending or descending order by clicking
the yellow arrow up or down. Look below to see a list sorted by date, indicated by the yellow arrow.
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Each Webliography entry contains the following information:

Title of the Web site• 
Clickable address (URL) of the Web site• 
The Web site's grade level and/or category.• 
The name of the person who posted the Webliography entry.• 
The date which the Web site was entered in the Webliography database.• 
A short description of the Web site. You may toggle between Concise and Verbose (as
shown above) views of the description.

• 

search

You can search for resources by entering a keyword(s) into the search box and clicking Search. The tool will
display a list of resources containing your keyword.

Advanced Search options allow you to make your search more specific by narrowing the Category, Grade
Level, etc.

CTAP Online Help Desk
CLIENT BILL OF RIGHTS

Help Desk Chat Room:

9am − 4pm weekdays

Help Desk E−mail:

help@ctaponline.org

Definitions:

Client: A teacher or other educator who uses CTAP Online.
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Help Desk: Communication channels and resources for client assistance.

Site Administrator: A designated person at a school site or district who supports and
manages CTAP Online for teachers.

Our Pledge to You

Overview

All CTAP Online clients may use the Help Desk to request assistance via e−mail, chat room
or discussion forum.

Response Time

The Help Desk staff will attempt to resolve issues immediately. When immediate resolution is
not possible, staff will inform the client of the date and time they can expect resolution.

Unresolved Issues

In the event that a client is not satisfied with the resolution, the client is encouraged to ask to
escalate the request. If the escalation request is via chat, the client will be transferred to the
appropriate CTAP Online staff person immediately. If the request is via e−mail, staff will
respond with the name of the person who will provide assistance, and the time the client can
expect help.

Enhancement Requests

If the Help Desk staff determines that a client's issue is an enhancement request, the Help
Desk staff will work with CTAP Online staff to determine an appropriate response. Help
Desk staff will then communicate that response to the client.

Help Resources

E−mail Support

Support is open to all Clients via links on many pages of the site (primarily
help@ctaponline.org and webmaster@ctaponline.org). Several times a day the Lead Help
Desk Assistant reads all incoming mail and handles them in accordance to the guidelines
described above. Messages are sent from the staff member's personal account.

Chat Room

The chat room is monitored from 9:00 AM − 4:00 PM business days. Access is open to all
Clients via a Home Room link. To minimize the chance of missing a Client's question,
typically 2 or 3 staff members monitor the room. If a question is missed, the Lead Help Desk
Assistant contacts the client immediately by e−mail or phone.

Help Discussion Forum

Access is open to all Clients via a Home Room link. The forum is monitored at least three
times weekly by the Lead Help Desk Assistant. Responses are posted as well as e−mailed
directly to the Client requesting assistance.
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Help Documents

Online: A wide variety of help documents are accessible via links on many pages.

Printed: A Tool and Feature Guide is distributed during face−to−face Site Administrator
trainings. We encourage the duplication and distribution of the document at school sites. The
document is also included as a printable Adobe Acrobat file on the Admin CD−ROM.

Phone Support

Phone support is restricted to CTAP Online Site Administrators. Clients are encouraged to
contact their Site Administrators or use Help Desk resources: e−mail, chat and/or forum.

Mission Statement

The CTAP Online Help Desk supports clients to enable their successful completion of online professional
development with the ultimate goal of enhancing teaching and learning for students.
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